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[MMS101 SDK for Arduino] User’s Guide:

Instruction Manual

OUTLINE

This document is the instruction manual of "MMS101 SDK for Arduino”.

“MMS101 SDK for Arduino” is a System Design Kit (SDK) consisting of a Shield which is connected to Arduino, a conversion board, the
sample sketch, and an evaluation application. You can easily check the operation of the sensor by using the Sample Sketch. This kit is an
expanded part of Arduino board and not operable alone.

For details on each sensor, refer to the applicable data sheet.

CAUTION

This kit is a design / sales promotion tool specifically for our products.

Therefore, we do not provide any guarantees for the performance, reliability, management of contained substances, export management,
and others regarding this kit.

Please let us know that we will replace it if it is defective in its initial state.
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1 Configuration

1-1 Kit Configuration
This kit consists of below:

Conversion Board Expansion Board Cable

Sample Sketch Evaluation App.

e ]
MMS101_SDK_for_ Arduino ForceSensorEvaIuatioh

Parsr. Ve PicoBlade(8p) Cable _Sample_Sketch.ino Program Ver.4.0.0.x
MMS101 SPI1 Shield 300mm(*1)

MMS101C SPI1 Cnv.BD
+ FPC Cable (*2)

(*1) The equivalent product is the Molex PicoBlade(8p) cable (Model No. 15134-0803).

If you need additional purchases of different lengths, please use commercially available FPC cable.
(*2) The equivalent product is the Molex FPC cable (Model No. 15032-0215).

If you need additional purchases of different lengths, please use commercially available FPC cable.

Force Sensor Sample

MMS101BXXA

You can choose whether or not to include the force sensor sample by configuring your purchase
set.

For details, please refer to “Ordering information”.

*Please use a conversion board that is compatible with each model.

MMS101C09

This kit does not include the following items. Please prepare them yourself.
Arduino USB cable PC

Arduino IDE

Please prepare a USB
cable that can be used
with Arduino.

»
D
B
4
-1
z
s
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2 Usage form
Connect the evaluation kit as shown below.

MMS101 SPI1 Shield Sample Sketch / Evaluation App.

MMS101B SPI1 Conv.BD

USB cable

PC
Force Sensor Sample
MMS101BXXA PicoBlade(8p) Cable Arduino
3 Compatible Arduino models
This kit is applicable to UNO, LEONARDO, DUE, MEGA2560 and UNO R4.
If you're using the UNO R4, please refer to "How to apply UNO R4",
Model UNO LEONARDO DUE MEGA2560 UNO R4

View ; ‘
"L A2
e
Hee
W
: Lod
A
M ol
o o
.
¢H
System
Power 5.0v 5.0V 3.3V 5.0V 5v
Supply
IET;'; Data Rate > 1msec Data Rate > 1msec Data Rate >= 1msec Data Rate > 1msec Data Rate >= 1msec

(*1) The data rate is the execution period of the loop() function in the sample sketch. It depends on the capabilities of the Arduino's CPU.
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4 Sample Sketch

4-1 File configuration
[MMS101_SDK_for_Arduino_Sample_Sketch]
F MMS101_SDK_for_Arduino_Sample_Sketch.ino : Main Processing

4-2 Upload the sample sketch

(1) Download the Arduino IDE
The Arduino IDE is required to upload the Sample Sketch to the Arduino. Download the Arduino IDE from the URL below.
Download HP: https://www.arduino.cc/en/software

(2) Launch the Arduino IDE

||:n.|.n_-.|_'-;.|»;.-. W o v

s [ar feene Dok s

(3) Make the Arduino IDE recognize the Arduino (in the case of DUE).

Select [Tools] Select [Tools]
-> [Board:” Arduino Due (Programming Port)”] -> [Port]
-> [Arduino ARM (32-bits) Boards] -> [COMxx(Arduino Due(Programming Port))]

-> [Arduino Due (Programming Port)]

o

(4) Load the sample sketch on the Arduino IDE.
Select [File]
-> [Open---]
-> [MMS101 SDK for Arduino Sample Sketch.ino] file select
-> [Open] button click

e - <

) dhonch, bk | A LA | e T LT e iy S
Foe [ar fhmcn Foot siey Dt et

thamr Ll
G T — e —
Cpm. W U p—

[rer— '

- ; |

[

[ [ =
.

e ey

fete.  CuTRRg

Fupe oy Cuie e

L ]
Fees Cuiet L.
[ o

et ]

©2025 Mitsumi Electric Co., Ltd. All rights reserved. The contents of this document are subject to change without notice. The details listed here are not a guarantee.

MITSUMI ELECTRIC CO., LTD. Semiconductor Business div.

https://product.minebeamitsumi.com/en/product/category/ics/



https://product.minebeamitsumi.com/en/product/category/ics/
https://www.arduino.cc/en/software
https://www.arduino.cc/en/software

MMS101 SDK for Arduino User’s

Guide

(5) How to change Arduino model
[In the sample sketch, the code for DUE is initially set. Change the code given below according to the Arduino model to use.

e A, Samgte e . Bk

-For use of UNO

" s 30 §define ARDUINO_VER UNOC
[ ' «For use of DUE
; 3 fdefine ARDUINO_ VER DUE
! For use of LEONARD
| $define ARDUINO_VER LEONARDO
3{ " «For use of MEGA2560
30 #define ARDUINO_VER MEGA2560
(6) Verify the sample sketch and upload it to Arduino.
Click [Verify] button Click [Upload] button

0 a5 o o ks, Sample_Sheich | Arduing 1L @ s Mg, Sampla Shich | Arckins LA19

ih Tohi Hele

©2025 Mitsumi Electric Co., Ltd. All rights reserved. The contents of this document are subject to change without notice. The details listed here are not a guarantee.

MITSUMI ELECTRIC CO., LTD. Semiconductor Business div.

https://product.minebeamitsumi.com/en/product/category/ics/



https://product.minebeamitsumi.com/en/product/category/ics/

User’s Guide

MMS101 SDK for Arduino

4-3 How to use the serial monitor / serial plotter
This kit allows you to monitor data using the serial monitor/serial plotter included with the Arduino IDE.

4-3-1 How to launch the serial monitor/serial plotter
For the serial monitor For the serial plotter
Select [Tools] Select [Tools]
-> [Serial Monitor] -> [Serial Plotter]

vt "CORTT ks D (Popmmins P
ottt

Frepren
[

= © cour
Y T TR

L1 = = F = L
Fd E

- Delimiter: Newline /" "\ -Delimiter: Newline
-Baud rate: 250,000

-Baud rate: 250,000

4-3-2 Evaluation procedure

(1) START: input [S] or [s]
For the serial monitor For the serial plotter
© com - o % S — SR
H Serd 1

iy ==
© counr o s
)
- ~tiosmaq
15 4 > - L3 |
1

hY
| Send

250000 baud |8

(2) STOP: input [P] or [p]
For the serial monitor For the serial plotter )
c QoM - o x o‘w LLLEL L ) : ’
i} Send -
" \ = U s
u 250000 baud | P Send
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4-4 How to change the Arduino model settings
In the sample sketch, the code for DUE is initially set. Change the code given below according to the Arduino model to use.

[ows RERE R

-For use of UNO

" srrenexe 30 §define ARDUINO_VER UNO
[ 5 B -For use of DUE
30 §define ARDUINO_VER DUE
-For use of LEONARD
$define ARDUINO_VER LEONARDO
-For use of MEGA2560
30 #define ARDUINO_ VER MEGZ2560

4-5 How to change the delimiter
Data output of the Sample Sketch is initially comma-separated.
To change the delimiter, change the character between double quotations to the desired character as shown below.

© MMS101_SDK_fer_Arduine Ssmple_Sketeh | Arduins 1.819

- (=] x

File Edit Sketch Took Help

MME101_SDK_for_Arduino_Sampla_Sketch

P ——— -~

[usec)

10000

3 pericimed every N times

*Useof comma: Char sep[2] = ",";

- Use of semicolon: char sep[2] = ";";

cemand set fox SFIL Converalon Boazd
SPI1_CMD_START OxFO
SP11_CMD_DATA 0xEQ
SPI1_CMD DATAD 0xE2
ne SPIL_CMD BESTART  OxCO
ra SETI £MD ROOT neRn
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4-6 How to apply UNO R4

If you are using the UNO R4 when the sample sketch is not yet compatible with it, please apply the following code to the sample sketch.
4-6-1 SPI communication
Modify the code in the setup() function as follows;

-Please delete the code below

11449 S5PI.setDataMode (SPI_MODE3) ; £/ 5PI Mode:3
i;é S5PI.setBitOrder (MSEFIRST) ; S/ M5B first '
1151 SPI.setClockDivider (SPI CLOCE DIVE); /f SCLE=:2ZMH=z :

S/ Initialize SPI
SPI.begin():

SPI.setDataMode (SFI_MODE3) ; // 5PI Mode:3
5FI.setBitOrder (MSBFIRST) ; ff M5B first3
SPFI.setClockDivider (SPI_CLOCE_DIVE): ff SCLE=2MH=z

SPI.beginTransaction (SPISettings (2000000, MSBFIRST, SPI_MODE3)):

4-6-2 Serial communication
If you are using the application, please add “Serial.dtr();" to the setup() function.

137 wolid setup() {

1 1
1 1
1 138 uintd t axis; |
i 1349 uintd_t count; i
1 14 1
| 4= 1
i 141 Serial.begin{250000) ; S/ serial boudrate: 250000bps i
r1az | Serial.der(; ) . !
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5 Evaluation application

5-1 File configuration
The file configuration of the evaluation application is as follows.

[ForceSensor_EvaluationProgram_ver.3.0.0.x]

|- ForceSensor_EvaluationProgram.exe: Application
F NPlot.dll: Library for drawing graphs

F OpenTK.dIl: Library for drawing graphs

- OpenTK.GLControl.dll: Library for drawing graphs
I [Settings]: Settings storage folder

|- [UserData]: Data storage folder

5-2 How to use the evaluation application

5-2-1 Launch the evaluation application
When the app is started, a “Start up” dialog will be displayed. Click “SDK for Arduino(USB)".

85 Form_Startup

Evakitl
(usB)

- [m] X

Evakitb Evakitd SDK for Arduino
(USB) (Ethernet) (USB)

This app has been confirmed to work on Windows 10, and 11

This app requires .NET Framework 4.8. An installation guide is available on the Microsoft website (URL below), so please install it according

to your environment.

Microsoft .NET Framework install guide homepage URL:
https://learn.microsoft.com/ja-jp/dotnet/framework/install/
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5-2-2 Display screen

Initiation button

(Read matrix correction coefficient from the AFE IC

Inside the sensor. Then the sensor operation is started.
The button turns light green while sensor is operating.)

Data acquisition interval setting
*The setting is 1-10000msec (1msec step)

Number of measurement setting
Number of measurement times

Logging start button

Logging sFop button

__Offset cancel button
(Change to light green when ON state)

Data save button

| 85 MMS101 Evaluation Program
COM Selection
|

GCOM Select
COM32 w

Set

= O x

emo

Tntervallmsec] 1
Restart Times 100

INIT.

Measuring Cycles 3800000

Maasuring Gount 0

QFFSET

BT CANCEL

STOP Bave Log

(Continuous measurement data is output as a CSV file)

Log Separator Selection
|__(select the delimiter
format for log data)

Ex 0 ol T T T e Log Separator
— Fy {| [3comms -
Fy 0 - Fz
20 -
Fz o]
N | ]
¥ Width
Fx,Fy,Fz of E [?Nu]
measurement value Fx,Fy,Fz measurement graph
-0 B
Offset temperature
correction update| setting ok 1
(Offset temperature
correction is perfarmed for ELS 1
! 1 1 . L ! L !
each‘s_e_t number of data : o5 5 3 5 3 35 + T A
ach|5|t|0ns.) Measured Time[s]
AT
Wb 0 o1 T T T T T M
- X
— My
Tty a - Mz
Mz ol °*°r 7
MNm
. ¥ Width
Mx, My, Mz o Mx,My,Mz RIET 57 M oz
measurement valtie [hm]
005 -
a1 . . . . . . . . .
0 0.5 1 15 2 25 3 35
Measured Time[s] | R idth 5 = 10 [sec]

|| Application Version : 4.0.0.3|| Firmware Version XXX _:

Fx,Fy,Fz measurement graph
Y-axis scale setting
(Set around 0 N)

Mx,My,Mz measurement graph
Y-axis scale setting
(Set around 0 Nm)

Measurement graph

X-axis scale setting

(The maximum value that
can be set changes
depending value of interval)
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5-2-3 Basic instruction for use

| @5l MMS101 Evaluation Program - O X
COM Select
[comsz ]
Set
1 3600000
(1) Intervallmses] INIT. Measuring Gycles Save Log
Restart Times 100 Measuring Gount 0
T T T T T T Log Separator
P o of @ 3)0) (4) @) 8 —Fx ]
—Fy] LXomme
Fy 0 - Fz
2 B
Fz 0
| N 10 B
| Y Width
| of b L
W]
ol 1 O
20 ]
| a0 B
L I I I L L L L I
0 0.5 1 15 2 25 3 35 4 45 5
Measured Time[s]
0.1
Mx 0 T T T T T =
— My
Ty 0 - Mz
M g o9 g
Nm
¥ Wiidth
°r 7| 02
[Nm]
005 E (5)
01 1 1 1 1 1 1 1 1 1
0 0.5 1 15 2 25 3 35 4 T
Measured Time[s] HWidth 5 = 10 [sec] |(6)

Application Version : 4.0.0.3 || Firmware Version X.X.X.i

(1) Select the COM port on the evaluation board. Click the “Set” button.
The COM port depends on the PC.
(2) Enter Interval[msec] and Restart Times.
The temperature sensor value for offset/temperature control is updated every number of times the numerical value set in Restart Cycles
is acquired.
e.g. Restart Times=0 : Temperature sensor value acquisition is the first time only. No temperature value updating is performed thereafter.
Restart Times=1 : Update temperature sensor value every time
Restart Times=10 : Temperature sensor value updated once every 10 data acquisitions
(3) Click the “INIT.” button.
The sensor operation is started.
The “INIT.” button turns light green while the sensor is operating.
Click it again to stop the sensor operation.
(4) Enter Measuring Cycles.
The settable number of measurements is 2,147,483,647 at the maximum.
Since the number of measurements depend on the PC specification, it should be set so that "the number of measurements x 64 bytes"
is less than "available PC memory".
(5) Enter Y Width. (Value can be changed even during measurement)
(6) Enter X Width. (Value can be changed even during measurement)
(7) Click the “START” button. => The data logging starts.
(8) Click the “STOP” button. => The data logging stops.
The logging process will stop automatically once the data for the "Measuring Cycles” count has been acquired, even without clicking
the “STOP” button.
(9) Click the “INIT.” button => The sensor operation stops.
The sensor operation is stopped.
The “INIT.” button turns gray after the sensor operation stops.
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5-2-4 Offset cancel procedure
The sensor output has an initial offset. Offset also occurs in the mounted condition or in gravity.

It is possible to cancel the offset deviation with the “OFFSET CANCEL” button.

Click the “OFFSET CANCEL” button again to cancel the offset cancel.

— o X

| B MMS101 Evaluation Program

COM Select
COM32

Set

Fx 0.008

Fy  -0006

M= —Q00006
I My 000007

Wiz —000046

Nm

Fz -0.002
N

20

Intervallmsee] &

Click “OFFSET CANCEL" button => Button turns light green.

- Measuring Cycles START QEESET Save Log
Restart Times 100 Measuring Gount 2038
T T Log Separator
- Fx
- Fy
- Fz
f Width
10
N
I L I I I I I L I
55 5 65 7 78 5 85 9 a5 10
Measured Times]
T T T T
= Mx
L " My
- Mz
f Width
o 0.05
[Nm)
I L L I I L L I I
55 [ 65 7 75 8 85 B 55 10
Measured Time[s] X ifidth & = 50 [sec]
Application Version : 4.0.0.3 || Firmware Version X XX

“OFFSET CANCEL" button-press point

Pressing the “OFFSET CANCEL” key averages the last
10 readings and cancels the offset.

3

1 —om0eTT

oo,

Click “OFFSET CANCEL” button again.
=>Button turns gray.

|

“OFFSET CANCEL" button-pressed point
Cancel the offset cancel.

A

Please click the "OFFSET CANCEL" button after more than 5min has elapsed since sensor operation started to use.
*It is recommended that the output (initial-drift) stabilization wait time after sensor activation be equal to or greater than 5min.
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5-2-5 Measurement data saving procedure
The data acquired by measurement can be saved with the “Save Log” button.
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(1) Select the log separator.
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(2) Click the “Save Log” button.

The following window will be displayed. Enter the file name and
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click the “Save” button
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6 Board configuration
6-1 Expansion Board: MMS101 SPI1 Shield Ver.1.0

Connector (¥1)
530470810

6-2 Conversion Board: MMS101B SPI1 Conv.BD Ver.1.0

LDO (for Build-in LDO supply of sensor analog) _ LDO (for sensor digital power supply)
TC1015-4.0VCT713 TLV70012QDDCRQ1

- =

Connector (*1)
532610871

Connector (for Sensor connection)
FH52K-20S-0.55H

Level Shifter

74LVC2T45DC,125 FPGA

LCMX02-2000ZE-1UWG49

6-3 Conversion Board: MMS101C SPI1 Conv.BD Ver.1.0

LDO (for Build-in LDO supply of sensor analog) LDO (for sensor digital power supply)
TC1015-4.0VCT713 TLV70012QDDCRQ1

Connector (for Sensor connection)

i
Connector (*1) i
532610871 5 FH36W-155-0.3SHW

Level Shifter

74LVC2T45DC, 125 FPGA

LCMX02-2000ZE-1UWG49
Pin assign : Connector(*1)

No. | Pin Name | Function

1 VDD Analog power supply (4.5 ~ 6.0V)

2 VDDIO Digital I/O power supply (2.0 ~ 5.5V)
3 SCLK Serial clock for SPI

4 SDI Serial Data Input for SPI (MOSI)

5 CSB Chip select for SPI (negative logic)

6 SDO Serial Data Output for SPI (MISO)

7 GND Ground

8 NC -
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7 Schematic circuit diagram
7-1 Expansion Board: MMS101 SPI1 Shield Ver.1.0
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7-2 Conversion Board: MMS101B SPI1 Conv.BD Ver.1.0
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7-3 Conversion Board: MMS101C SPI1 Conv.BD Ver.1.0
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8 Layout diagram
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8-2 Conversion Board: MMS101B SPI1 Conv.BD Ver.1.0
Mounting hole: ©1.8
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8-3 Conversion Board: MMS101C SPI1 Conv.BD Ver.1.0

Mounting hole: ©1.8
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9 BOMlist

9-1 Expansion Board: MMS101 SPI1 Shield Ver.1.0
Designator Model Maker Parts name Value Q'ty
C1 GRM188R61E106KA73D muRata Capacitor 10u 1
Cc2 CGA3E2X7R1H104K080AA TDK Capacitor 0.1u 1
CN1 530470810 Molex Connector 8pin 1
CN21, CN24 85 Adafruit Industries Pin header 8pin 2
CN22 85 Adafruit Industries Pin header 6pin 1
CN23 85 Adafruit Industries Pin header 6pin 1
CN25 85 Adafruit Industries Pin header 10pin 1
R1, R2, R3, R4 RK73H1JTTD49R9F KOA Resistor 49.9 4

9-2 Conversion Board: MMS101B SPI1 Conv.BD Ver.1.0
Designator Model Maker Parts name Value Q'ty
C1, C9 GRM155R61A474KE15D muRata Capacitor 4.7u 2
C2,C3,C4,C5 GRM155R61E105KA12D muRata Capacitor 1u 4
C6, C7, C8, C12, C13, Ci4, C15, .
C16, C17, C18, C19, C20, C21, C22 GCM155R71C104KA55D muRata Capacitor 0.1u 14
C10, C11 GRM155R61A106ME11D muRata Capacitor 10u 2
C23 GCM1555C1H471JA16D muRata Capacitor 470p 1
CN1 FH52K-20S-0.5SH Hirose Electric Connector 20pin 1
J1 532610871 Molex Connector 8pin 1
J2 XB-1-3 6pin Mac8 Pin header OPEN 1
R1, R2, R12, R13 RK73H1ETTP1000 KOA Resistor 100 4
R3, R7, R8 RMC1/16SK472FTH KAMAYA Resistor 4.7k 3
R4, R5, R10, R11 RK73H1ETTP49ROF KOA Resistor 49.9 4
R6 RMC1/16SK103FTH KAMAYA Resistor 10k 1
R9 RK73H1ETTP2201F KOA Resistor 2.2k 1
TH1 - - Through hole ®1.8 1
TH2 - - None TH ®1.8 1
TP1, TP2, TP3, TP4, TP5, TP6, TP7 | - - Test land ®1.0 7
Ul TC1015-4.0VCT713 Microchip Technology | LDO 4.0,100mA |1
U2 TLV70012QDDCRQ1 Texas Instruments LDO 1.2V,300mA | 1
U3, U5, U6 74LVC2T45DC, 125 Nexperia USA Inc. Level shifter - 3
U4 LCMX02-2000ZE-1UWG49 Lattice Semiconductor | FPGA - 1
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9-3 Conversion Board: MMS101C SPI1 Conv.BD Ver.1.0
Designator Model Maker Parts name Value Q'ty
C1, C9 GRM155R61A474KE15D muRata Capacitor 4.7u 2
C2,C3,C4, C5 GRM155R61E105KA12D muRata Capacitor 1u 4
Ce6, C7, C8, C12, C13, C14, C15, .
C16, C17, C18, C19, C20, C21, C22 GCM155R71C104KA55D muRata Capacitor 0.1u 14
C10, C11 GRM155R61A106ME11D muRata Capacitor 10u 2
C23 GCM1555C1H471JA16D muRata Capacitor 470p 1
CN1 FH36W-155-0.3SHW Hirose Electric Connector 15pin 1
J1 532610871 Molex Connector 8pin 1
J2 XB-1-3 6pin Mac8 Pin header OPEN 1
R1, R2, R12, R13 RK73H1ETTP1000 KOA Resistor 100 4
R3, R7, R8 RMC1/16SK472FTH KAMAYA Resistor 4.7k 3
R4, R5, R10, R11 RK73H1ETTP49R9F KOA Resistor 49.9 4
R6 RMC1/16SK103FTH KAMAYA Resistor 10k 1
R9 RK73H1ETTP2201F KOA Resistor 2.2k 1
TH1 - - Through hole ®1.8 1
TH2 - - None TH ®1.8 1
TP1, TP2, TP3, TP4, TP5, TP6, TP7 | - - Test land ®1.0 7
Ul TC1015-4.0VCT713 Microchip Technology | LDO 4.0v,100mA | 1
U2 TLV70012QDDCRQ1 Texas Instruments LDO 1.2V,300mA | 1
U3, U5, U6 74LVC2T45DC,125 Nexperia USA Inc. Level shifter - 3
U4 LCMX02-2000ZE-1UWG49 Lattice Semiconductor | FPGA - 1
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10 MMS101B SPI1 Conv.BD Ver.1.0 Communication Specification

10-1 Description

The conversion board MMS101B SPI1 Conv.BD Ver.1.0 (hereafter referred to as SPI1 Conv.BD) consolidates the six SPI wires of the force
sensor MMS101BXXA into one SPI wire to communicate with the host controller.

The communication specifications for the conversion board MMS101C SPI1 Conv.BD Ver.1.0 are also the same.

SPI x6

SPI x1

Host Controller

PicoBlade(8p) Cable

Force Sensor

MCU, Arduino, Rasp Pi etc. MMS101BXXA

MMS101B SPI1 Conv.BD Ver.1.0

10-2 SPI communication settings
Host controller and SPI1 Conv.BD communicate using SPI. SPI communication settings are as follows.

Item Settings

Mode Mode3(CPOL=1,CPHA=1)
Baud rate ~ 2MHz

Data length 8 bit

Data transmission direction MSB First

Byte order Big Endian

10-3 Communication

data format

SPI1 Conv.BD always returns a response to the received command. The basic communication format is as follows.

CSB —|

ML 1
Command | Command Command
SDI 1D Option[0] Option[N]
Response | Response Response
SDO Status Data[0] Diata[N]
Command format
Byte Name Details
Indication code of the command instructed to SPI1 Conv.BD. Refer to “Command
0 Command ID list”
1 Command Option[0 N
- - ption[0] If there is a parameter associated with Command ID, it is appended. For multiple
- ; byte data, the byte order is big-endian.
N+2 Command Option[N] vt vt g

Response format

Byte Name Details

0 Response Status This is the result of executing the command. Refer to “Status Code list".

1 Response Dat:

- - po ata[0] If there is anything order than the response status, it is appended. For multiple byte
- - data, th t is big-endian.

NT2 Response Data[N] ata, the byte order is big-endian
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10-4 Command list
The command to instruct SPI Conv.BD is as follows.

Name Command ID | Operation

START 0xFO Command to start measurement for SPI1 Conv.BD

DATA2(*1) 0xE2 Command to read ADC data from SPI1 Conv.BD

RESTART 0xCO Command to update temperature sensor value for offset temperature correction of
MMS101

BOOT 0xBO Command to read and hold the matrix correction coefficient from MMS101 by
SPI1 Conv.BD

STOP 0xB2 Command to stop measurement for SPI1 Conv.BD

RESET 0xB4 Command to reset SPI1 Conv.BD and MMS101

STATUS 0x80 Command to read status of SPI1 Conv.BD

VERSION 0xA2 Command to read version of SPI1 Conv.BD

COEFF 0x30(*2) Command to read the matrix correction coefficient held by SPI1 Conv.BD

INTERVAL Oxd4 Command to update temperature sensor value for offset temperature correction of
MMS101 at set cycle

(*1) Please execute the matrix operation by user’s system.
(*2) Command ID is different for each axis. (Fx=0x30. Fy=0x32. Fz=0x34. Mx=0x36. My=0x38. Mz=0x3A)

10-4-1 START command
Command to start measurement for SPI1 Conv.BD. SPI1 Conb.BD acquires ADC data from MMS101 at 1msec intervals and holds the latest
data. Please execute this command when in READY state.

Command format

Byte Data Details
0 Command ID=0xF0
Response format
Byte Data Details
0 Status Code Refer to “Status Code list”
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10-4-2 DATA2 command
Command to read ADC data (before the matrix operation) from SPI1 Conv.BD. To obtain force data, perform matrix operation on the ADC
data. Obtain the matrix correction coefficients in advance with COEFF command. Please execute this command when in MEASURE state.

Command format
Byte Data Details
0 Command ID=0xE2

Response format

Byte Data Details

0 Status Code Refer to “Status Code list”.
1-2 Measure Status Refer to “"Measure Status list”.
3-5 FxADC

6-8 FyADC

9-11 FzADC

12-14 MxADC
15-17 MyADC
18-20 MzADC

ADC data for each axis.

Matrix operation formula:
FxMD = Al * FXADC + A2 * FyADC + A3 * FzZADC + A4 * MxADC + A5 * MyADC + A6 * MzADC

MzMD = F1 * FXxADC + F2 * FyADC + F3 * FzADC + F4 * MxADC + F5 * MyADC + F6 * MzADC

Unit conversion formula:
Fx = FxMD / 2711 [*0.001 N]

Mz = MzMD / 2”11 [*0.00001 Nm]

For details, please refer to “Matrix operation” in the data sheet.

10-4-3 RESTART command
Command to update temperature sensor value for offset temperature correction of MMS101. Please execute this command when in
MEASURE state.

It is also possible to set the automatic update cycle of temperature sensor value using INTERVAL command.

Command format
Byte Data Details
0 Command ID=0xC0

Response format
Byte Data Details
0 Status Code Refer to “Status Code list”

©2025 Mitsumi Electric Co., Ltd. All rights reserved. The contents of this document are subject to change without notice. The details listed here are not a guarantee.

MITSUMI ELECTRIC CO., LTD. Semiconductor Business div.

https://product.minebeamitsumi.com/en/product/category/ics/



https://product.minebeamitsumi.com/en/product/category/ics/

MMS101 SDK for Arduino User’s Guide

10-4-4 BOOT command
Command to read and hold the matrix correction coefficients from MMS101. Please execute this command when in STANDBY state.

Command format
Byte Data Details
0 Command ID=0xB0

Response format
Byte Data Details
0 Status Code Refer to “Status Code list”

10-4-5 STOP command
Command to stop measurement for SPI1 Conv.BD. Please execute this command when in MEASURE state.

Command format
Byte Data Details
0 Command ID=0xB2

Response format
Byte Data Details
0 Status Code Refer to “Status Code list”

10-4-6 RESET command
Command to reset the internal information and the matrix correction coefficients in SPI1 Conv.BD. Execute reset on MMS101. After
executing this command, it changes to STANDBY state.

Command format
Byte Data Details
0 Command ID=0xB4

Response format
Byte Data Details
0 Status Code Refer to “Status Code list”

10-4-7 STATUS command
Command to read status of SPI1 Conv.BD. This command can be executed in any state.

Command format
Byte Data Details
0 Command ID=0x80

Response format

Byte Data Details

0 Status Code Refer to “Status Code list”
1-2 Measure Status Refer to “"Measure Status list”
3 State ID Refer to “State ID list”
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10-4-8 VERSION command
Command to read the hardware version and firmware version of SPI1 Conv.BD. This command can be executed in any state.

Command format
Byte Data Details
0 Command ID=0xA2

Response format

Byte Data Details

0 Status Code Refer to “Status Code list”

1-2 Hardware version Indicates the two-digit hardware version
3 Firmware version Indicates the four-digit firmware version

10-4-9 COEFF command
Command to read the matrix correction coefficients held by SPI1 Conv.BD. It is necessary to obtain the matrix correction coefficients from
MMS101 in advance using the BOOT command. Command ID is different for each axis. Please execute this command when in READY state.

Command format

Byte Data Details

0 Command ID=0x30 0x30 = Fx, 0x32 = Fy, 0x34 = Fz, 0x36 = Mx, 0x38 = My, 0x3A = Mz
Response format

Byte Data Details

0 Status Code Refer to “Status Code list”

1-3 Coefficient Datal matrix correction coefficient 1 (Al ~ F1)

4-6 Coefficient Data2 matrix correction coefficient 2 (A2 ~ F2)

7-9 Coefficient Data3 matrix correction coefficient 3 (A3 ~ F3)

10-12 Coefficient Data4 matrix correction coefficient 4 (A4 ~ F4)

13-15 Coefficient Data5 matrix correction coefficient 5 (A5 ~ F5)

16-18 Coefficient Datab matrix correction coefficient 6 (A6 ~ F6)

10-4-10 INTERVAL command
Command to update temperature sensor value for offset temperature correction of MMS101. When the number of data acquisitions reaches
the Interval value, the temperature sensor value for offset temperature correction is updated and the number of data acquisitions is reset.
The temperature sensor value is automatically updated at the interval of the Interval value. This command can be executed in any state.
The number of data acquisitions will also be reset when RESTART command is executed.

Command format

Byte Data
0 Command ID=0x44
13 Interval = 0~10,000,000 0:Temperature updates are not performed automatically.

N(>0):The temperature sensor value is updated after data is acquired N times.

Response format
Byte Data Details
0 Status Code Refer to “Status Code list”
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10-5 Status Code list

The execution result of the received command is shown below.

Status Code | Details

0x00 OK No error

0x01 Busy Access denied (Respond to on illegal state)

0x81 Not Support Respond to an illegal Command ID

0x82 Illegal Command Respond to an illegal command format

0x83 Illegal Parameter Respond to an illegal parameter (out of range)
10-6 Measure Status list

When an error occurs in SPI1 Conv.BD, the corresponding bit becomes 1. If there are no errors, all bits are 0.
(Example) If a communication error with the Fx axis occurs during BOOT processing, b0 and b6 will be 1.

Bit Details

b0 Fx NACK

bl Fy NACK

b2 Fz NACK Communication error when accessing the corresponding axis of
b3 Mx NACK MMS101 (MMS101 responded NACK)

b4 My NACK

b5 Mz NACK

b6 BOOT Error Communication error during BOOT processing

b7 START Error Communication error during START processing

b8 MEASURE Error Communication error during MEASURE processing
b9 Not Update New data is not ready

b10 RESTART Error Communication error during RESTART processing
b1l STOP Error Communication error during STOP processing

b12 RESET Error Communication error during RESET processing
b13-b15 Reserved -

10-7 State ID list
The state of SPI1 Conv.BD is shown below.

K& ID Operation
INITIAL 0 Internal initialization after power-on
STANDBY 1 Waiting state for BOOT command after internal initialization is completed
BOOT 2 Acquisition operation of the matrix correction coefficients from MMS101
READY 3 Holds the matrix correction coefficients and waits for START command
Updated sensor data at 1msec intervals
MEASURE 4 Output the latest data held by DATA2 command
Execute reset command to MMS101
RESET 5 Initialize the internal information and the matrix correction coefficients of
SPI1 Conv.BD
Transitions when an Error occurs
ERROR 255 Wait until the RESET command is executed from host
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10-8 State transition diagram
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“\_ (ID=255)

0

10-9 State transition table

State
INITIAL STANDBY BOOT READY MEASURE RESET ERROR
START / / / ->MEASURE / / /
DATA2 / = = = = = =
RESTART / / / / = / /
o BOOT / ->BOOT / / / / /
g STOP / / / / ->READY / /
g RESET / ->RESET ->RESET ->RESET ->RESET / ->RESET
O | STATUS / = = = = = =
VERSION / = = = = = =
COEFF / = = / /
INTERVAL / = = = = / /
[->] Transmission state  [=] Keep state  [/] Ignore (Return Busy)
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10-10 Outline of measurement operation

Host

Controller

SPI1 Conv.BD

MMS101

RESET Command Reset MMS5101BXxA
Preparation of Reset internal parametears
measurement =
BOOT Command
> Reguest of the matrix correction coefficients
= 2
COEFF Command " . I
— > _Ou tput _Ije matrix correction coefficients
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INTERVAL Command (*1) ~
e RN S
START Command "
< Request of the start measurement N
rF #

Measurement Measurement operation Measurement operation is
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stop instruction is issued o Conversion board Lnti
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Update saved data Output data
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DATAZ Command (any timing) N = vl
< Ed |Update saved data Outputdaty
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|::| Matrix operation
ey b TN Ty
RESTART Command (any timing) (*2) Reguest to update femperature sensor value
> for offset temperature correctdon (*1,2) “ Update the temperature
s sensor value
st STOP Command N
op rd Reqguest of stop measurement -
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(*1)(*2) The temperature sensor value for offset temperature correction is updated according to the INTERVAL Command and RESTART

Command.
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11 Ordering Information

11-1

ER 15101B

PO No. Description
-04N

Set

N : Kit Only

S 1 Kit with Sample
No.

ex)

0# : Kit Fullset

B# : Board

C# : Cable
Delimiter

Model Name

ex)

S101B : MMS101BXXA

S101C: MMS101C09
Subscript

Classification

11-2

Conversion Board
(MMS101 SPI1 Conv.BD)

Force Sensor Sample

Lineup

EM : Mitsumi Evaluation Kit
EA : SDK for Arduino (Expansion Board for Arduing)
ER. : SDK for RaspPi (Expansion Board for RaspPi)

Conversion Board
(MMS101C SPI1 Conv.BD)

FPC Cable
(Molex 15032-0215(*2))

Shield (MMS101 SPI1 Shield)

Force Sensor Sample

Shield (MMS101 SPI1 Shield)

(MMS101BXXA) PicoBlade(8p) Cable 300mm . .o (MMS101C09) PicoBlade(8p) Cable 300mm Arduino
(Molex 15134-0803(*1)) (Molex 15134-0803(*1))
PO No Details Contents
) Product Name |Kit Name |Set Main Contents |Sample |Accessary1 |Accessary2
MMS101B
MMS101B ) MMS101 MMS101B PicoBlade(8p) Cable
EA1S101B-04N  |MMS101BXXA Kit Onl
SDK for Arduino | " SPI1 Shield no SPI1 Conv.BD  |300mm (*1)
MMS101B L MMS101 MMS101B PicoBlade(8p) Cable
EA1S101B-04S  |MMS101BXXA Kit with Sampl MMS101BXXA
SDK for Arduino | V" P Ispry shield SPI1 Conv.BD  |300mm (*1)
EA1S101B-B1 MMS101BXXA MMS101B Accesso MMS101B - - -
SPI1 Conv.BD i SPI1 Conv.BD
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PO No Details Contents
: Product Name |Kit Name Set Main Contents |Sample Accessaryl |Accessary2
MMS101C
MMS101C .
EAISI01C-04N  [MMS101C09 m(sfl:rl/fr quino KON g::flsohliel . | SPI1 Conv.BD zggi';dfgg’ ) Cable
+ FPC Cable(*2)
MMS101C .
EA1S101C-045  |MMS101C09 | ot0IC G ith Sample |otOL MMS101C09  |SPI1 ConvBD || coBlade(8p) Cable
SDK for Arduino SPI1 Shield 300mm (*1)
+ FPC Cable(*2)
MMS101C MMS101C
EA1S101C-B1 MMS101C09 SPI1 Conv.BD Accessory SPI1 Conv.BD - - -

(*1) The equivalent product is the Molex PicoBlade(8p) cable (Model No. 15134-0803).

If you need additional purchases of different lengths, please use commercially available FPC cable.
(*2) The equivalent product is the Molex FPC cable (Model No. 15032-0215).

If you need additional purchases of different lengths, please use commercially available FPC cable.
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11-3 Evaluation Kit List

Evaluation Kit Name

Configuration / Features

MMS101 SDK for Arduino

Shield
(MMS101 SPI1 Shield)

Sample Sketch / Evaluation App.

Conversion Board
(MMS101 SPI1 Conv.BD)

Force Sensor Sample

(MMS101BXXA) Cable Arduino
(MMS101 SPI1 Cable-300)

#External Communication: USB

#Arduino is not included.

Is g
ﬁ&mzﬁc SPI1 Conv.BD) Shield (MMS101 SPI1 Shield)
FPC Cable YUTNRryF | SHET T

(Molex 15032-0215(*2))

Force Sensor Sample

(MMS101C09) PicoBlade(8p) Cable Arduino
(Molex 15134-0803(*1))

#External Communication: USB

@ Arduino is not included.

Conversion Board
(MMS101 SPI1 Conv.BD)

Force Sensor Sample PicoBlade(8p) Cable Raspberry Pi 4 B
(MMS101BXXA) (Molex 15134-0803(*1))

#Up to five sensors can be connected.
#Raspberry Pi is not included.

MMS101 SDK for Raspberry Pi

Conversion Board
(MMS101C SPI1 Conv.BD)

AddOn Board (MMS101 SPI1 AddOn Board)

FPC Cable
(Molex 15032-0215(*2))

Force Sensor Sample PicoBlade(8p) Cable Raspberry Pi 4 B
(MMS101C09) (Molex 15134-0803(*1))

#Up to five sensors can be connected.
#Raspberry Pi is not included.
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Conversion Board Evaluation Board

Evaluation App.

Force Sensor Sample

(MMS101BXXA) Cable _
(MMS101 Evakit Lead Cable-30cm)

& External communication : USB
MMS101 Evakitl FPC Cable

(Molex 15032-0215(*2)) Evaluation Board )
(MMS101 Evakit1 BD) Evaluation App.

Conversion Board
(MMS101C Conv.BD)

Force Sensor Sample

(MMS101C09) Cable
(MMS101 Evakit Lead Cable-30cm)

& External communication : USB

Evaluation Board

Gonversion Board (MMS101 Evakit5 BD)

(MMS101B Conv.BD)

Evaluation App.

Force sensor :
(MMS101BXXA) Cable for sensor connection

(MMS101 Evakit Lead Cable-30cm)

#External communication : Ethernet / USB
#Up to five sensors can be connected (Only in Ethernet).

MMS101 Evakit5

FPC Cable Evaluation Board
(Molex 15032-0215(*2)) (MMS101 Evakit5 BD)
Conversion Board
(MMS101C Conv.BD) Evaluation App.
Force sensor I
(MMS101C09) Cable for sensor connection

(MMS101 Evakit Lead Cable-30cm)

& External communication : Ethernet / USB
#Up to five sensors can be connected (Only in Ethernet).

(*1) The equivalent product is the Molex PicoBlade(8p) cable (Model No. 15134-0803).

If you need additional purchases of different lengths, please use commercially available PicoBlade(8p) cable.
(*2) The equivalent product is the Molex FPC cable (Model No. 15032-0215).

If you need additional purchases of different lengths, please use commercially available FPC cable.
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[Contact]

Mitsumi Electric Co., Ltd.
Semiconductor Division, Design Engineering Department

1601, Sakai, Atsugi-shi, Kanagawa, 243-8533 JAPAN
TEL:046-230-3367
URL : https://product.minebeamitsumi.com/contact/
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Disclaimers

Disclaimers (Handling Precautions)

1. All the information described herein (product data, specifications, figures, tables, programs, algorithms and application
circuit examples, etc.) is current as of publishing date of this document and is subject to change without notice.

2. The circuit examples and the usages described herein are for reference only, and do not guarantee the success of any
specific mass-production design.

MITSUMI ELECTRIC CO., LTD. is not liable for any losses, damages, claims or demands caused by the reasons other
than the products described herein (hereinafter "the products") or infringement of third-party intellectual property right
and any other right due to the use of the information described herein.

3. MITSUMI ELECTRIC CO., LTD. is not liable for any losses, damages, claims or demands caused by the incorrect
information described herein.

4. Be careful to use the products within their ranges described herein. Pay special attention for use to the absolute
maximum ratings, operation voltage range and electrical characteristics, etc.

MITSUMI ELECTRIC CO., LTD. is not liable for any losses, damages, claims or demands caused by failures and / or
accidents, etc. due to the use of the products outside their specified ranges.

5. Before using the products, confirm their applications, and the laws and regulations of the region or country where
they are used and verify suitability, safety and other factors for the intended use.

6. When exporting the products, comply with the Foreign Exchange and Foreign Trade Act and all other export-related
laws, and follow the required procedures.

7. The products are strictly prohibited from using, providing or exporting for the purposes of the development of weapons
of mass destruction or military use. MITSUMI ELECTRIC CO., LTD. is not liable for any losses, damages, claims or
demands caused by any provision or export to the person or entity who intends to develop, manufacture, use or store
nuclear, biological or chemical weapons or missiles, or use any other military purposes.

8. The products are not designed to be used as part of any device or equipment that may affect the human body, human
life, or assets (such as medical equipment, disaster prevention systems, security systems, combustion control systems,
infrastructure control systems, vehicle equipment, traffic systems, in-vehicle equipment, aviation equipment, aerospace
equipment, and nuclear-related equipment), excluding when specified for in-vehicle use or other uses by MITSUMI
ELECTRIC CO., LTD. Do not apply the products to the above listed devices and equipment.

MITSUMI ELECTRIC CO., LTD. is not liable for any losses, damages, claims or demands caused by unauthorized or
unspecified use of the products.

9. In general, semiconductor products may fail or malfunction with some probability. The user of the products should
therefore take responsibility to give thorough consideration to safety design including redundancy, fire spread
prevention measures, and malfunction prevention to prevent accidents causing injury or death, fires and social damage,
etc. that may ensue from the products' failure or malfunction.

The entire system in which the products are used must be sufficiently evaluated and judged whether the products are
allowed to apply for the system on customer's own responsibility.

10. The products are not designed to be radiation-proof. The necessary radiation measures should be taken in the
product design by the customer depending on the intended use.

11. The products do not affect human health under normal use. However, they contain chemical substances and heavy
metals and should therefore not be put in the mouth. The fracture surfaces of wafers and chips may be sharp. Be
careful when handling these with the bare hands to prevent injuries, etc.

12. When disposing of the products, comply with the laws and ordinances of the country or region where they are used.

13. The information described herein contains copyright information and know-how of MITSUMI ELECTRIC CO., LTD.
The information described herein does not convey any license under any intellectual property rights or any other rights
belonging to MITSUMI ELECTRIC CO., LTD. or a third party. Reproduction or copying of the information from this
document or any part of this document described herein for the purpose of disclosing it to a third-party is strictly
prohibited without the express permission of MITSUMI ELECTRIC CO., LTD.

14. For more details on the information described herein or any other questions, please contact MITSUMI ELECTRIC CO.,
LTD.'s sales representative.

15. This Disclaimers have been delivered in a text using the Japanese language, which text, despite any translations into
the English language and the Chinese language, shall be controlling.

Disclaimers - Ver.1.00
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